Kepler - Issues

# Tracker Status Priority Subject Assignee Updated

7190 Bug Resolved Normal memory leak due to hierarchy listeners when cloning Christopher Brooks 05/22/2017 02:51 PM
7191 Bug Resolved Normal memory leak in CompositeActor for actor firing listeners Christopher Brooks 05/18/2017 02:57 PM
6928 Bug Resolved Normal Check Kepler for the Apache commons deserialization problems, consider removing the Daniel Crawl 01/04/2016 02:05 PM

commons-collections-3.2.1 jar file
3466 Bug Works For Me Normal workflow can fail to load when using ParameterSet Chad Berkley 12/23/2015 02:16 PM
6634 Bug Closed Normal Error message popup not generated when saving to a write protected directory. Christopher Brooks 12/22/2015 02:51 PM
6371 Bug Resolved Normal Documentation: missing content in section 1.1.1 Features Daniel Crawl 09/17/2015 12:14 PM
6577 Bug Resolved Normal infinite loop resolving port width Daniel Crawl 09/12/2015 12:12 PM
6833 Feature Resolved Normal syntax highlighting for language actors Daniel Crawl 09/11/2015 11:11 AM
5720 Feature Resolved Normal Kepler component documentation layout needs improvement Daniel Crawl 09/11/2015 09:38 AM
6834 Bug Resolved Normal kepler data can icon displayed incorrectly Christopher Brooks 09/10/2015 01:19 PM
4516 Bug Resolved Normal Module Manager needs ability to install modules needed by KARs Daniel Crawl 08/30/2015 04:18 PM
5668 Bug Resolved Normal module manager should support batch mode execution. Daniel Crawl 08/30/2015 04:09 PM
6831 Bug Closed Normal saving/loading window properties for multiple graphs/models in BasicGraphFrame Christopher Brooks 08/17/2015 01:14 PM
5490 Bug Resolved Normal update splash screen version without changing image Matt Jones 08/17/2015 09:20 AM
5894 Bug Closed Normal Clone problems in NamedObjld Christopher Brooks 08/17/2015 08:30 AM
5659 Bug Closed Normal Kepler CaseGraphFrame and CaseGraphTableau have duplicated Ptolemy code. Daniel Crawl 08/17/2015 08:10 AM
5716 Bug Resolved Normal Module Manager should only print Downloading messages when actually downloading Daniel Crawl 08/16/2015 07:02 PM
5722 Bug Resolved Normal Check for problems with sanitized RecordToken labels Daniel Crawl 08/14/2015 04:18 PM
5893 Bug Closed Normal During installation, Kepler takes a long time to start up under Windows Christopher Brooks 08/12/2015 04:46 PM
6615 Bug Resolved Normal apple-extensions does not compile with java 8 Daniel Crawl 08/12/2015 03:32 PM
6681 Bug Resolved Normal unnecessary warnings when removing parameters 03/04/2015 10:34 AM
5424 Bug Resolved Normal see if it's worthwhile to upgrade hsql from 1.8 Daniel Crawl 02/05/2015 10:16 AM
6572 Bug Resolved Normal An error is thrown when opening MatlabExpression.xml in common/workflows/demos/Matlab in trunk. Daniel Crawl 12/23/2014 03:28 PM
5665 Bug Resolved Normal modulemanager et al.: swing-worker-1.2.jar should be removed Daniel Crawl 12/23/2014 03:19 PM
6386 Bug Resolved Normal cannot drop second matlab actor on canvas Daniel Crawl 07/15/2014 10:31 AM
6467 Bug Closed Normal data tab no longer works Jing Tao 04/11/2014 05:57 PM
6233 Bug Resolved Normal DirectoryListing NPE Daniel Crawl 11/20/2013 07:10 PM
6000 Bug Closed Normal parameter copy-paste exception on console. Christopher Brooks 11/18/2013 02:19 PM
5726 Bug Resolved Normal actor names ending in digit renamed on canvas Daniel Crawl 07/03/2013 04:52 PM
5723 Bug Resolved Normal references to parameter are not always renamed Daniel Crawl 06/28/2013 10:44 AM
5278 Bug Resolved Normal HSQL database is shared between users Daniel Crawl 04/16/2013 10:32 AM
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5901 Bug Resolved Normal Kepler window sometimes only has Reporting view. 04/10/2013 10:26 AM
5838 Bug Works For Me Normal incomplete transfer of error messages into serialized WorkflowRun xml Derik Barseghian 04/08/2013 02:38 PM
5601 Bug Closed Normal Can still lose report design when saving to KAR Derik Barseghian 04/02/2013 11:06 AM
5895 Bug Resolved Normal HelloWorld link is broken under Kepler-2.4rc3 Daniel Crawl 03/20/2013 03:38 PM
5891 Bug Resolved Normal Installer acks need to be update for Ptolemy Derik Barseghian 03/20/2013 10:44 AM
4989 Bug Resolved Normal The installer should offer to start Kepler Chad Berkley 03/19/2013 03:50 PM
5892 Bug Resolved Normal After running various demos like HelloWorld, the user is prompted to save changes to kar Daniel Crawl 03/19/2013 02:42 PM
5890 Bug Resolved Normal kepler crash on mac when clinking 'KeplerData' during saving process. Derik Barseghian 03/14/2013 10:09 AM
5725 Bug Resolved Normal Save dialog's folder drop-down menu crashes kepler in OS X 10.8 w/ 64-bit java Derik Barseghian 03/14/2013 10:09 AM

1.6.0_37-b06-434-11M3909

5458 Bug Resolved Normal Moving between 2.2 and 2.3 and back requires deleting ~/KeplerData jianwu jianwu 03/11/2013 01:43 PM
5487 Bug Resolved Normal blank modules.xt files created for non-suite modules jianwu jianwu 03/11/2013 11:51 AM
5573 Bug Resolved Normal remove ptolemy vendors/ Christopher Brooks 03/07/2013 02:25 PM
5700 Bug Resolved Normal after getting an actors patch, actor changes won't be visible to user until .kepler is removed Daniel Crawl 03/07/2013 02:24 PM
5790 Bug Resolved Normal Not all remote run-kars appear in Workflow Run Manager Derik Barseghian 01/29/2013 02:41 PM
5789 Bug Resolved Normal component tree disappears after clicking Clear after downloading KAR Daniel Crawl 01/23/2013 01:50 PM
5727 Bug Resolved Normal saving workflow changes canvas center Daniel Crawl 01/16/2013 07:26 PM
5781 Bug Resolved Normal opening a workflow run leaves temp kar entry in Recent Files menu and changes last directory setting | Derik Barseghian 01/15/2013 01:41 PM
5782 Bug Resolved Normal wrong behavior when trying to Export a run when module dependencies not satisfied Derik Barseghian 01/15/2013 01:40 PM
5778 Bug Resolved Normal Force Open doesn't (always?) currently work with Workflow Run Manager Derik Barseghian 01/15/2013 01:39 PM
5759 Bug Resolved Normal MatrixViewer window does not reappear Daniel Crawl 01/15/2013 09:34 AM
5266 Bug Resolved Normal Two empty boxes inside Sinewave actor and other icon problems for attributes Christopher Brooks 12/07/2012 10:39 AM
5598 Bug Resolved Normal parameters appear as white boxes instead of dots Daniel Crawl 11/30/2012 04:10 PM
5754 Bug Closed Normal unable to open TestSSHWithDisplay 2.3 run-kar from keplerRepository with WRM trunk Derik Barseghian 11/30/2012 02:06 PM
4903 Bug Resolved Normal Text in attributes not rendered properly Sean Riddle 11/29/2012 07:30 PM
5732 Bug Resolved Normal EML 2.1.1 option should be added to metacat data sources in kepler Jing Tao 11/27/2012 04:45 PM
5625 Bug Resolved Normal create kepler documentation for 2.4 jilanwu jianwu 11/26/2012 03:22 PM
5397 Bug Resolved Normal "./kepler.sh -runwf -nogui workflow.xml" doestn't work if the user is logged out on Mac David Welker 11/26/2012 02:57 PM
5745 Bug Resolved Normal "./kepler.sh -runwf -nogui -nocache workflow.xml" has error message after execution. jianwu jianwu 11/26/2012 02:47 PM
5714 Bug Resolved Normal user manual documentation for 2.4. jianwu jianwu 11/14/2012 05:29 PM
5677 Bug Resolved Normal SDF lterations now defaults to AUTO jianwu jianwu 11/14/2012 03:42 PM
5713 Bug Resolved Normal getting-started-guide documentation for Kepler 2.4 jianwu jianwu 11/14/2012 03:37 PM
5485 Bug Resolved Normal standalone Module Manager can break Kepler app ability to startup Derik Barseghian 11/06/2012 05:45 PM
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5712 Bug Resolved Normal illegal option chmod error during Kepler startup Derik Barseghian 10/30/2012 03:46 PM
5711 Bug Resolved Normal post release process cheatsheet Derik Barseghian 10/02/2012 12:39 PM
5719 Bug Resolved Normal parameter values no longer appear on canvas Derik Barseghian 10/01/2012 06:13 PM
5642 Bug Resolved Normal Kepler should have access to the ShowTypes attribute Sean Riddle 10/01/2012 01:28 PM
5629 Bug Resolved Normal Mac DMG installer should have better background and license agreement jilanwu jianwu 09/24/2012 03:56 PM
5279 Bug Resolved Normal HSQL databases use default account Daniel Crawl 09/21/2012 02:38 PM
5650 Bug Resolved Normal actors LidarWorkflowExecute and load WorkflowExecute have duplicated code Daniel Crawl 09/20/2012 03:44 PM
5655 Bug Resolved Normal sdm spa Repeat is a duplicate of a Ptolemy actor jilanwu jianwu 09/20/2012 10:39 AM
5489 Bug Resolved Normal Module Manager GUI should fail gracefully if a remote module cannot be downloaded Derik Barseghian 09/19/2012 04:18 PM
5259 Bug Resolved Normal kepler/util/src/util/LineReader.java should be updated to match Ptolemy sources Derik Barseghian 09/18/2012 02:01 PM
5651 Bug Resolved Normal WebService, WebServiceStub and MessageBasedWebService have duplicate code Daniel Crawl 09/18/2012 11:41 AM
5662 Bug Resolved Normal resurgence ArrayAccumulator is a duplicate of Ptolemy ArrayAccumulate Derik Barseghian 09/17/2012 09:44 PM
5653 Bug Resolved Normal Geon ArrayContains is a duplicate of a Ptolemy actor Derik Barseghian 09/17/2012 08:36 PM
5654 Bug Resolved Normal Geon ArrayRemoveElement is a duplicate of a Ptolemy actor Derik Barseghian 09/17/2012 08:21 PM
5656 Bug Resolved Normal sdm spa StringConst is a duplicate of a Ptolemy actor Derik Barseghian 09/17/2012 06:27 PM
5680 Bug Resolved Normal after inline save, demo workflow disappears from tree Daniel Crawl 09/17/2012 06:03 PM
5648 Bug Resolved Normal FileCopier code duplication Sean Riddle 09/17/2012 11:46 AM
5701 Bug Resolved Normal CT was removed, demo workflows need to be updated Daniel Crawl 09/14/2012 09:22 PM
5657 Bug Resolved Normal kepler moml FileAttribute should probably be a FileParameter Daniel Crawl 09/14/2012 02:24 PM
5649 Bug Resolved Normal opendap/{DapObjectsToToken, TokenManager, TypeManager} are almost identical Daniel Crawl 09/14/2012 02:22 PM
5637 Bug Resolved Normal composite window size & position not always saved Daniel Crawl 09/12/2012 09:40 PM
5188 Bug Resolved Normal closing workflow does not save the location change of popup display windows. Daniel Crawl 09/12/2012 09:31 PM
5702 Bug Resolved Normal GUI bug - Initial actor port positioning is wrong Derik Barseghian 09/07/2012 11:08 AM
5688 Bug Resolved Normal library not working in kepler trunk in windows?7 Derik Barseghian 09/07/2012 11:03 AM
5703 Bug Resolved Normal GUI bug - Deleting an Actor with connected port causes a diamond relation to be created. Christopher Brooks 09/07/2012 10:27 AM
5681 Bug Resolved Normal Tracking bug for sensor-view-0.9.0 release testing Derik Barseghian 08/30/2012 09:37 PM
5684 Bug Resolved Normal Add warning to archiving workflow that it must be run on one machine to not produce overlapping Derik Barseghian 08/30/2012 06:09 PM

datasets

5683 Bug Resolved Normal archiveDataturbineDataToMetacat.kar can fail with an IOException on win7 and XP Jing Tao 08/30/2012 05:57 PM
5587 Bug Resolved Normal long parameter values get replaced with scrollbar Christopher Brooks 08/29/2012 09:44 PM
5457 Bug Resolved Normal Mac OS X: Kepler.app should display module error messages in a window Christopher Brooks 08/29/2012 08:21 PM
5403 Bug Resolved Normal Improve the performance of the workflow archiving data from dataturbine to metacat Derik Barseghian 08/24/2012 07:35 PM
5588 Bug Resolved Normal Enter and Tab behavior has changed in parameter configuration dialog Daniel Crawl 08/24/2012 01:02 PM
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5398 Bug Resolved Normal Re-install of Kepler-x.y doesn't overwrite modules.ixt jilanwu jianwu 08/24/2012 10:19 AM
5661 Bug Resolved Normal Remove SwingWorker and use javax.swing.SwingWorker Jing Tao 08/23/2012 11:49 AM
5529 Bug Resolved Normal Documentation for some actors such as Run Composite Actor is empty Daniel Crawl 08/22/2012 05:34 PM
4068 Bug Resolved Normal File Menu should display 5 most recently used workflows Daniel Crawl 08/18/2012 04:57 PM
5280 Bug Resolved Normal missing command line execution for KAR files Daniel Crawl 08/18/2012 04:55 PM
5660 Bug Resolved Normal ExtensionFileFilter is a duplicate of a Ptolemy class Daniel Crawl 08/17/2012 06:49 PM
5426 Bug Resolved Normal workflow Isid changes when running from command line Daniel Crawl 08/17/2012 06:49 PM
5546 Bug Resolved Normal SDF director iterations parameter default of 0 is unfriendly Christopher Brooks 08/15/2012 07:15 AM
5602 Bug Resolved Normal Timezone confusion using the scheduler Jing Tao 08/14/2012 06:33 PM
5416 Bug Resolved Normal downloaded modules by Kepler module manager should know the path of main Kepler installation. jilanwu jianwu 08/08/2012 05:31 PM
5495 Bug Resolved Normal released kepler should allow getting patches and changing suites from command line jilanwu jianwu 08/08/2012 03:47 PM
5663 Bug Resolved Normal KeplerGraphFrame has much duplicated code Christopher Brooks 08/07/2012 05:23 PM
5348 Bug Resolved Normal Opening KAR or opening workflow under KAR behaves differently. jilanwu jianwu 08/07/2012 04:05 PM
5658 Bug Resolved Normal Rename kepler/moml/filter classes so that they don't have the same name as the Ptolemy filter classes | Derik Barseghian 08/06/2012 10:39 PM
4926 Bug Resolved Normal Examine Kepler for duplicated Ptolemy code Christopher Brooks 08/06/2012 05:00 PM
5247 Bug Resolved Normal Allow user to set memory allocated to Kepler from within Kepler Derik Barseghian 08/06/2012 03:29 PM
5418 Bug Resolved Normal Build System resets modules.txt during update Derik Barseghian 08/06/2012 12:40 PM
5440 Bug Resolved Normal special checkout behavior for hardcoded ptolemy module names jilanwu jianwu 08/06/2012 12:07 PM
5607 Bug Resolved Normal constant actor icon won't automatically re-size since 2.3. Christopher Brooks 08/06/2012 11:47 AM
5580 Bug Resolved Normal create sensor-view module documentation Derik Barseghian 08/03/2012 02:05 PM
5509 Bug Resolved Normal How do | run the demos Daniel Crawl 07/31/2012 12:45 PM
5452 Bug Resolved Normal uneasy access to the demo workflows Daniel Crawl 07/31/2012 12:43 PM
5589 Bug Resolved Normal Add missing ptolemy actors to library Daniel Crawl 07/27/2012 05:37 PM
5415 Bug Resolved Normal module releasing and downloading by module manager should keep file mode. jilanwu jianwu 07/27/2012 01:30 PM
5643 Bug Resolved Normal [Fatal Error] :79:7: The element type "nextDiagram" must be terminated by the matching end-tag Derik Barseghian 07/25/2012 02:41 PM

"</nextDiagram>".
5194 Bug Resolved Normal demos are difficult to find Daniel Crawl 07/13/2012 03:43 PM
5638 Bug Resolved Normal "Ok" behavior of Use Module Manager prompt doesn't do what it should when opening from Recent Derik Barseghian 07/13/2012 10:58 AM
Files

4846 Bug Resolved Normal error opening kar from local repository Chad Berkley 07/12/2012 04:11 PM
3003 Bug Resolved Normal Copy/Paste of selection: copy should be selected Christopher Brooks 06/28/2012 09:38 PM
5283 Bug Resolved Normal Ul for saving workflows as xml is confusing Daniel Crawl 06/28/2012 04:25 PM
4147 Bug Resolved Normal Error message with selectable text ben leinfelder 06/28/2012 11:02 AM
5636 Bug Resolved Normal outreach/demos/Database/Database_example_1.xml workflow fails jianwu jianwu 06/27/2012 04:47 PM
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5635 Bug Resolved Normal build-area should have a licenses.txt jianwu jianwu 06/27/2012 04:38 PM
5052 Bug Resolved Normal default file open directory of Kepler 2.0 Christopher Brooks 06/27/2012 10:20 AM
2571 Bug Resolved Normal position of new elements on screen Christopher Brooks 06/26/2012 01:04 PM
2335 Bug Resolved Normal MENUS: Top-Level Menu - dynamic addition of menu items Daniel Crawl 06/26/2012 12:08 PM
5634 Bug Resolved Normal Kepler should have Configure Layout menu choices Daniel Crawl 06/26/2012 11:56 AM
5550 Bug Resolved Normal Windows installer should be a .exe, not a .jar Christopher Brooks 06/26/2012 10:57 AM
5576 Bug Resolved Normal memory leak in ptolemy.data.expr.CachedMethod Daniel Crawl 06/25/2012 11:20 AM
5539 Bug Resolved Normal Open Actor does not find the actor source code when Kepler is invoked from within Eclipse Derik Barseghian 06/24/2012 10:23 AM
5610 Bug Resolved Normal check that build system can handle a "0.9.0" release Derik Barseghian 06/22/2012 05:20 PM
5606 Bug Resolved Normal move plotting classes to sensor-view Derik Barseghian 06/18/2012 07:02 PM
5349 Bug Resolved Normal Cannot open KAR file after modifying it. jilanwu jianwu 06/18/2012 02:55 PM
5449 Bug Resolved Normal Running ant should include instructions about updating kepler-tasks.jar David Welker 06/17/2012 04:51 PM
3801 Bug Resolved Normal open dialog, common places pane has white box instead of text Christopher Brooks 06/17/2012 01:57 PM
5623 Bug Resolved Normal Outline tab context menu problems Daniel Crawl 06/15/2012 04:02 PM
5545 Bug Resolved Normal Configure Ports dialog Type column gui annoyances Derik Barseghian 06/15/2012 03:54 PM
5240 Bug Resolved Normal NameDuplicationException from SequencePlotter Christopher Brooks 06/15/2012 03:29 PM
5565 Bug Resolved Normal deal with licensing for oracle jar in core Daniel Crawl 06/15/2012 02:30 PM
5571 Bug Resolved Normal user request: show execution time in runtime window Christopher Brooks 06/15/2012 02:23 PM
5286 Bug Resolved Normal Remove the override of EntityTreeModel Derik Barseghian 06/15/2012 02:19 PM
5072 Bug Resolved Normal Move the R module out of Kepler/CORE entirely. Derik Barseghian 06/15/2012 12:33 PM
5174 Bug Resolved Normal Reduce the number of modules in Kepler CORE. llkay Altintas 06/15/2012 12:06 PM
5448 Bug Resolved Normal cannot start Kepler using non-lcedTea OpenJDK Christopher Brooks 06/15/2012 11:48 AM
5498 Bug Resolved Normal Issue a patch for ptolemy classpath problem in kepler-2.2 Derik Barseghian 06/15/2012 11:47 AM
5579 Bug Resolved Normal Upload to Repository on actors doesn't work Derik Barseghian 06/15/2012 11:41 AM
5378 Bug Resolved Normal add rety logic to SpanTodt, attempt to recover if RBNB goes down Derik Barseghian 06/14/2012 08:45 PM
5399 Bug Resolved Normal "./kepler.sh -runwf -nogui -nocache" command will not quit if some parameters are set. David Welker 06/14/2012 11:51 AM
5578 Bug Resolved Normal Add DiffModules with build-area Derik Barseghian 06/14/2012 11:51 AM
4711 Bug Resolved Normal Problem with L.H. actor tree: ActorName,kar Chad Berkley 06/13/2012 07:15 PM
5592 Bug Resolved Normal Site Layout DE Director missing documentation Derik Barseghian 06/13/2012 07:08 PM
5355 Bug Resolved Normal actor documentation not included on instantiation Daniel Crawl 06/13/2012 07:06 PM
5453 Bug Resolved Normal ant javadoc -Dfull=true fails likay Altintas 06/13/2012 07:04 PM
5406 Bug Resolved Normal "./kepler.sh -runwf -nogui" won't work if the workflow file path includes 'repository’ David Welker 06/12/2012 11:31 AM
4261 Bug Resolved Normal Long file name on windows Christopher Brooks 06/12/2012 08:35 AM
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2369 Bug Resolved Normal Scrollbars Disappear After Using Fullscreen Mode--Now crashes Christopher Brooks 06/12/2012 08:23 AM
5437 Bug Resolved Normal provenance hsqgldb database doesn't behave as though it's properly shutdown when in server mode Daniel Crawl 06/11/2012 04:06 PM
5603 Bug Resolved Normal ant run -Dworkflow=${HOME}/Downloads/SimpleLoop.kar fails Derik Barseghian 06/11/2012 01:58 PM
5381 Bug Resolved Normal run-workflow does not work for KAR files David Welker 06/11/2012 11:50 AM
5156 Bug Resolved Normal ant run for kepler 1.0 fails after clean svn checkout David Welker 06/11/2012 11:44 AM
5609 Bug Resolved Normal use different port for HSQL db in .kepler Daniel Crawl 06/11/2012 11:25 AM
5605 Bug Resolved Normal Kepler scheduler doen't work for local workflows in windows os Jing Tao 05/30/2012 08:55 AM
5595 Bug Resolved Normal GetMetadata Menu doesn't work in eml actor when it handles local eml document and data file Derik Barseghian 05/09/2012 10:55 AM
5540 Bug Resolved Normal Automate Layout no longer uses Kieler on trunk Derik Barseghian 05/01/2012 08:49 PM
5408 Bug Resolved Normal dataturbine actor should reuse connection Derik Barseghian 03/29/2012 06:49 PM
5404 Bug Resolved Normal change-sampling.kar demo no longer works Derik Barseghian 03/27/2012 07:49 PM
5575 Bug Resolved Normal open composites from outline tab Derik Barseghian 03/14/2012 11:51 AM
5574 Bug Resolved Normal exception from gui in java 7 Derik Barseghian 02/15/2012 08:57 PM
4974 Bug Resolved Normal ant run and ant force-ptolemy fail to compile an updated file Chad Berkley 01/11/2012 10:59 AM
5552 Bug Resolved Normal Workflow Scheduler GUI needs a licenses.txt file Jing Tao 12/21/2011 02:26 PM
5564 Bug Resolved Normal dragging sdf director to the canvas causes exception Derik Barseghian 12/06/2011 07:29 PM
5502 Bug Resolved Normal use https to svn check out modules Derik Barseghian 12/05/2011 06:23 PM
5486 Bug Resolved Normal Need a mechanism to tell the user the information about setup the scheduler and workflow run engine | Jing Tao 12/01/2011 09:20 AM
5456 Bug Resolved Normal Documentation for Reporting 2.3.0 Derik Barseghian 11/23/2011 02:53 PM
5508 Bug Resolved Normal Link to "Additional background information on Ptolemy" brings up empty page Christopher Brooks 11/22/2011 11:17 AM
5506 Bug Resolved Normal Windows Installer Page does not mention 2.3? Derik Barseghian 11/21/2011 07:29 PM
5549 Bug Resolved Normal Help=>Modules Documentation not working in ubuntu Derik Barseghian 11/21/2011 05:15 PM
5501 Bug Resolved Normal Got an java.lang.NullPointerException when click any menu after downloading a kar file David Welker 11/21/2011 03:13 PM
5504 Bug Resolved Normal Kepler incorrectly uses old version of a kar file in ~KeplerData/workflows/MyWorkflows David Welker 11/10/2011 05:37 PM
5507 Bug Resolved Normal Windows Installer: The R choice is not unselectable Derik Barseghian 11/08/2011 06:46 PM
5505 Bug Resolved Normal Kepler-2.3 installer should create directory named "Kepler-2.3", not "Kepler" Derik Barseghian 11/08/2011 06:38 PM
5450 Bug Resolved Normal Menu: Help -> Kepler Documentation causes lllegalArgumentException David Welker 11/03/2011 07:21 PM
4872 Bug Resolved Normal listen to director throws error Chad Berkley 11/03/2011 07:21 PM
5512 Bug Resolved Normal Provenance module does not work with MySQL (RecordingException: com.mysql.jbc Daniel Crawl 10/25/2011 10:20 AM

MysglDataTruncation)
5460 Bug Resolved Normal Mac OS X: Matlab Actors fail in Kepler.app David Welker 10/05/2011 05:38 PM
5473 Bug Resolved Normal 2.3.0rc1 won't start on Windows XP David Welker 09/30/2011 10:58 PM
5484 Bug Resolved Normal Module Manager GUI can fail to close and quit parent process David Welker 09/30/2011 10:55 PM
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5500 Bug Resolved Normal unable to open kar in relaxed mode saved in patched 2.2.0 in 2.3.0 Derik Barseghian 09/30/2011 10:03 PM
5496 Bug Resolved Normal non-English (United State) OS locale causes File menu and button text to not show Daniel Crawl 09/27/2011 04:42 PM
5442 Bug Resolved Normal View->Automate Layout doesn't work in kepler-2.3 branch David Welker 09/26/2011 05:34 PM
5494 Bug Resolved Normal existence of remote 2.2 patches can cause 2.3 to fail to start 2.2 on first attempt Derik Barseghian 09/22/2011 06:45 PM
5488 Bug Resolved Normal domain/username/password in command line hadn't been parsed in kepler when kepler needed them | Jing Tao 09/08/2011 04:58 PM

to access external data objects
5461 Bug Resolved Normal Add a directory to contain all modules in linux installer David Welker 08/22/2011 04:28 PM
5463 Bug Resolved Normal Provide security for Kepler databases Daniel Crawl 08/15/2011 02:18 PM
5462 Bug Resolved Normal Can't run the kepler by ./kepler.sh after decompressing the linux installer David Welker 08/15/2011 09:20 AM
5445 Bug Resolved Normal Kepler 2.2.0 tar file should create a kepler-2.2.0 directory David Welker 08/15/2011 09:01 AM
5459 Bug Resolved Normal Kepler 2.3 blocking bug David Welker 08/14/2011 04:13 PM
5432 Bug Resolved Normal 2.2 mac installer contains 2 copies of everything David Welker 08/12/2011 08:05 PM
5455 Bug Resolved Normal Documentation for 2.3.0 Derik Barseghian 08/12/2011 06:21 PM
5203 Bug Resolved Normal Kepler wont start Chad Berkley 08/10/2011 10:06 AM
5451 Bug Resolved Normal Componets ->(right mouse) View Dokumentation causes NameDuplicationException llkay Altintas 08/06/2011 10:51 AM
5454 Bug Resolved Normal DEBUG->ANIMATE EXECUTION error message David Welker 08/06/2011 10:50 AM
5430 Bug Resolved Normal problems with multiple instances of kepler Derik Barseghian 08/05/2011 07:59 AM
5447 Bug Resolved Normal Use https, not svn to check out the ptll repository David Welker 08/04/2011 02:01 PM
5342 Bug Resolved Normal ant update hangs if the svn certificate changes (and possibly always hangs the first time) David Welker 08/04/2011 11:37 AM
5438 Bug Resolved Normal missed menubar and misformed buttons without text David Welker 08/04/2011 09:57 AM
5270 Bug Resolved Normal No menu bar and labels when non-default locale is set David Welker 08/04/2011 09:55 AM
5446 Bug Resolved Normal View=>XML View broken David Welker 08/02/2011 04:25 PM
5436 Bug Resolved Normal KeplerConfigurationApplication does not show run exception David Welker 07/20/2011 01:56 PM
4047 Bug Resolved Normal Remove Component doesn't work Derik Barseghian 07/14/2011 12:26 PM
4967 Bug Resolved Normal Disallow dragging romls, workflowRuns, etc onto canvas Aaron Aaron 07/14/2011 12:22 PM
5419 Bug Resolved Normal Cannot open KARs saved in 2.1.0 suites in 2.2.0 in relaxed mode because ptolemy module changed David Welker 07/13/2011 02:24 PM
names

5441 Bug Resolved Normal no 'work will be lost' warning when accepting a patch via Module Manager David Welker 07/13/2011 02:22 PM
5439 Bug Resolved Normal file parameter ignores directory David Welker 07/11/2011 07:23 PM
5186 Bug Resolved Normal Publish example KARs to repository Derik Barseghian 07/08/2011 06:33 PM
5433 Bug Resolved Normal use 1024m instead of 512m for reporting suite Derik Barseghian 07/08/2011 03:37 PM
5320 Bug Resolved Normal Get "could not find entity 1876 in parameter table" when run the dataturbineToMetacat workflow Daniel Crawl 07/07/2011 02:21 PM
5434 Bug Resolved Normal run-kar result from headless kepler.sh execution doesn't contain report artifacts Derik Barseghian 06/30/2011 03:19 PM
5407 Bug Resolved Normal wrm/tagging have errors when starting with provenance turned off Derik Barseghian 06/22/2011 01:42 PM
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5158 Bug Resolved Normal remaining provenance issues for 2.1 release Daniel Crawl 06/21/2011 03:41 PM
5302 Bug Resolved Normal module_dependencies column defined too short Daniel Crawl 06/21/2011 01:34 PM
5091 Bug Resolved Normal Dragging and dropping report layout items NPEs Derik Barseghian 06/20/2011 04:25 PM
4247 Bug Resolved Normal Application menu items sometimes disappear on OS X Derik Barseghian 06/20/2011 04:00 PM
5410 Bug Resolved Normal provenance data is not flushed to HSQL database before Kepler quit. Daniel Crawl 06/16/2011 11:00 AM
5422 Bug Resolved Normal Tools=>Tag Manager... menu option is missing Sean Riddle 06/14/2011 06:48 PM
5420 Bug Resolved Normal Two types of NPE issues when 2.2.0 installed and run by a non-admin windows user David Welker 06/13/2011 12:57 PM
5412 Bug Resolved Normal saving with an open plot window crashes David Welker 06/10/2011 12:42 PM
5411 Bug Resolved Normal file->save to xml does not work David Welker 06/10/2011 12:40 PM
5409 Bug Resolved Normal reporting 2.1 can not start when setting "JDBC URL" in provenance. Daniel Crawl 06/06/2011 06:18 PM
5345 Bug Resolved Normal Kepler 2.2rc3 Copyright should be updated to 2011 David Welker 06/01/2011 07:18 PM
5414 Bug Resolved Normal fileparameter browse has NPE Christopher Brooks 05/31/2011 02:47 PM
5417 Bug Resolved Normal changes to a sensor's serial-number param do not get written to config file Derik Barseghian 05/31/2011 01:48 PM
5396 Bug Resolved Normal rename ptolemy-8.1.0 module for the kepler 2.2 release David Welker 05/25/2011 04:44 PM
4744 Bug Resolved Normal load & save site layout to local kar file Derik Barseghian 05/25/2011 04:19 PM
5318 Bug Resolved Normal 2.2.0 release testing David Welker 05/24/2011 05:05 PM
5352 Bug Resolved Normal build-area-2.1 is not working and build-area-2.2 is needed for kepler-2.2 release. David Welker 05/24/2011 04:57 PM
5326 Bug Resolved Normal 2.2rc2 - upgrade config file bug workaround moves KeplerData/modules to KeplerData/modules.old David Welker 05/24/2011 04:36 PM

instead of just configuration file dirs

5346 Bug Resolved Normal Kepler 2.2r3 Mac OS 64-bit Matlab demo fails with 'no suitable image found' David Welker 05/18/2011 04:55 PM
5402 Bug Resolved Normal Linux build at r27617 can't drag instantiate components David Welker 05/13/2011 03:58 PM
5390 Bug Resolved Normal EML created by DataTurbineToMetacat workflow should have the spatial coverage Derik Barseghian 05/04/2011 04:40 PM
5380 Bug Resolved Normal Save As no longer disposes old window Aaron Aaron 04/26/2011 05:00 PM
5361 Bug Resolved Normal Animate at Runtime broken Aaron Aaron 04/26/2011 03:45 PM
5351 Bug Resolved Normal Couldn't open a composite actor at the second time David Welker 04/18/2011 04:02 PM
5321 Bug Resolved Normal sensor settings made by kepler user lost on SPAN restart Daniel Crawl 04/18/2011 03:40 PM
5360 Bug Resolved Normal changes to a sensor parameter might not take effect until next current sample Derik Barseghian 04/18/2011 03:39 PM
5379 Bug Resolved Normal SPAN - add writing metadata changes to pending files Daniel Crawl 04/18/2011 02:03 PM
5253 Bug Resolved Normal SpanToDT timestamp bug Daniel Crawl 04/12/2011 03:02 PM
4443 Bug Resolved Normal gui-free class for provenance store settings Derik Barseghian 04/12/2011 03:01 PM
5332 Bug Resolved Normal crik_d doesn't reliably connect to logger Derik Barseghian 04/12/2011 11:48 AM
5098 Bug Resolved Normal Save Archive (KAR)... will have exception when internet is not accessible. Chad Berkley 04/11/2011 09:54 PM
5197 Bug Resolved Normal error from provenance when opening KAR from previous version Daniel Crawl 04/07/2011 11:16 AM
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5172 Bug Resolved Normal Exceptions are sometimes thrown during sensor workflow run Daniel Crawl 04/07/2011 11:14 AM
5375 Bug Resolved Normal data not sent out after accumulating a large number of files in pending/ Derik Barseghian 04/05/2011 04:42 PM
5356 Bug Resolved Normal ArchivingDataturbine workflow couldn't update the second sensor's lastArchiving time in command line |Jing Tao 04/04/2011 04:12 PM
mode
5324 Bug Resolved Normal dcd_mgr buffer too small -- xxx Lost data.. messages Derik Barseghian 04/04/2011 09:48 AM
5359 Bug Resolved Normal SpanToDT NoClassDefFoundError Derik Barseghian 03/30/2011 10:36 AM
5315 Bug Resolved Normal Sensor Site view Components only filtered when All Ontologies and Folders selected Derik Barseghian 03/29/2011 03:22 PM
5287 Bug Resolved Normal Remove the override of ActorMetadataKAREntryHandler Daniel Crawl 03/29/2011 02:35 PM
5358 Bug Resolved Normal CompositeActor name can disappear jianwu jianwu 03/24/2011 05:32 PM
5303 Bug Resolved Normal The workflow which archive sensor data into metacat can upload data even no new data was Jing Tao 03/22/2011 04:33 PM
generated
5319 Bug Resolved Normal The workflow which archive sensor data into metacat can upload incorrect data set when new data is Jing Tao 03/22/2011 04:30 PM
coming
5322 Bug Resolved Normal dcd_mgr crashes often Derik Barseghian 03/08/2011 02:43 PM
5337 Bug Resolved Normal NPE from WorkflowManager when configuring actor within composite Derik Barseghian 03/04/2011 01:29 PM
5335 Bug Resolved Normal SpanToDT should write metadata first rather than data when it starts up Daniel Crawl 03/04/2011 10:18 AM
5323 Bug Resolved Normal saving Site Layout workflow makes Sensor actor parameters editable Daniel Crawl 03/03/2011 03:10 PM
5334 Bug Resolved Normal 2.2 rc3: kepler.sh file is not executable by default in Kepler.app/Contents/Resources/Java/ directory David Welker 03/01/2011 05:21 PM
5331 Bug Resolved Normal Errors in Help->Kepler Documentation page at kepler 2.2 rc3. David Welker 03/01/2011 04:28 PM
5328 Bug Resolved Normal 2.2rc2 - standalone module manager won't start David Welker 02/28/2011 09:25 PM
5325 Bug Resolved Normal 2.2rc2 - documentation problems David Welker 02/28/2011 09:25 PM
5261 Bug Resolved Normal Get an error when execute the dataturbineToMetacat workflow in the second time Jing Tao 02/25/2011 11:11 AM
5310 Bug Resolved Normal 2.2.0rc1 - Documentation link problems David Welker 02/24/2011 02:11 PM
5235 Bug Resolved Normal Scheduler GUI can schedule any wf (even local ones). Jing Tao 02/23/2011 04:55 PM
5312 Bug Resolved Normal updating windowsXP installed 2.0.0 straight to 2.2.0 renders Kepler unable to start David Welker 02/22/2011 01:23 PM
4921 Bug Resolved Normal find reports for sensor in site layout Daniel Crawl 02/18/2011 04:50 PM
5311 Bug Resolved Normal 2.2.0rc1 - remote data sources don't work Jing Tao 02/17/2011 03:11 PM
4756 Bug Resolved Normal allow saving of sensor workflow output manish manish 02/17/2011 12:01 PM
4757 Bug Resolved Normal transfer sensor data from dataturbine to metacat manish manish 02/17/2011 12:00 PM
5214 Bug Resolved Normal Retrieve the last timestamp for which a sensor's data was stored in metacat manish manish 02/17/2011 12:00 PM
5216 Bug Resolved Normal Retrieve the timestamps for all the metadata changes that occurred since a previous time manish manish 02/17/2011 12:00 PM
5217 Bug Resolved Normal Retrieve the metadata of a sensor at a specific timestamp manish manish 02/17/2011 12:00 PM
5220 Bug Resolved Normal Create data chunks having same metadata info for a time interval manish manish 02/17/2011 12:00 PM
5221 Bug Resolved Normal Create EML string manish manish 02/17/2011 11:59 AM
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5222 Bug Resolved Normal Store data set file and associated EML file into metacat manish manish 02/17/2011 11:59 AM
5223 Bug Resolved Normal Store the last timestamp of data store for a sensor to the local database manish manish 02/17/2011 11:59 AM
5169 Bug Resolved Normal select more than one remote repository Daniel Crawl 02/16/2011 04:50 PM
5309 Bug Resolved Normal 2.2.0rc1 - Preferences and Components Search (configuration) issue David Welker 02/15/2011 10:32 PM
4745 Bug Resolved Normal load & save site layout to metacat Derik Barseghian 02/15/2011 06:32 PM
5296 Bug Resolved Normal Workflow Run Manager - multiple window, remote store gui refresh issue Derik Barseghian 02/14/2011 05:56 PM
5208 Bug Resolved Normal Setting sensor sampling rate <1 causes errors Daniel Crawl 02/14/2011 01:45 PM
5041 Bug Resolved Normal display recent data next to icon Daniel Crawl 02/14/2011 01:45 PM
5207 Bug Resolved Normal Sensor changes color in response to configuring the actor even if no changes made Daniel Crawl 02/14/2011 01:45 PM
5206 Bug Resolved Normal Importing or opening a sensor site doesn't open into the sensor site view Daniel Crawl 02/14/2011 01:45 PM
5205 Bug Resolved Normal Sensor site components not yet in tree Daniel Crawl 02/14/2011 01:45 PM
5042 Bug Resolved Normal create span simulator Daniel Crawl 02/14/2011 01:45 PM
5028 Bug Resolved Normal dataturbine overwrites recent data when frequently detaching Daniel Crawl 02/14/2011 01:45 PM
5164 Bug Resolved Normal Don't show Workflow Run Manager and tag workflow drop-down list on Schedule tab of Workflow Derik Barseghian 02/14/2011 01:45 PM

Scheduler view

5016 Bug Resolved Normal mirror dataturbine via command line Daniel Crawl 02/14/2011 01:45 PM
4755 Bug Resolved Normal update workflow run manager and reporting to display runs of sensor workflows Derik Barseghian 02/14/2011 01:45 PM
5050 Bug Resolved Normal Automatically filter workflow run manager runs based on selected workflow Derik Barseghian 02/14/2011 01:45 PM
5040 Bug Resolved Normal create views, tabs, configuration Daniel Crawl 02/14/2011 01:45 PM
5033 Bug Resolved Normal Workflow Run Manager - Allow multiple instances of WRM in one Kepler instance Derik Barseghian 02/14/2011 01:45 PM
4752 Bug Resolved Normal create a sensor plots gui Sean Riddle 02/14/2011 01:45 PM
5236 Bug Resolved Normal The list on the left panel of the scheduler should only show WF objects that can be scheduled. Jing Tao 02/14/2011 01:45 PM
5133 Bug Resolved Normal Authentication and authorization of GPP server Daniel Crawl 02/14/2011 01:45 PM
4760 Bug Resolved Normal software to transfer sensor data from SPAN to DT Daniel Crawl 02/14/2011 01:45 PM
5032 Bug Resolved Normal Workflow Run Manager - ability to connect to different prov stores from gui actions Derik Barseghian 02/14/2011 01:45 PM
4754 Bug Resolved Normal update metacat workflow execution scheduler Jing Tao 02/14/2011 01:45 PM
4748 Bug Resolved Normal create google earth kml from component coordinates Daniel Crawl 02/14/2011 01:45 PM
5213 Bug Resolved Normal Query dataturbine server to retrieve the sensors manish manish 02/14/2011 01:45 PM
5132 Bug Resolved Normal Connecting Workflow Run Manager to remote KAR store should prompt for credentials Derik Barseghian 02/14/2011 01:45 PM
4759 Bug Resolved Normal install dataturbine on gumstix Daniel Crawl 02/14/2011 01:45 PM
4743 Bug Resolved Normal create gui to edit documentation metadata for component Daniel Crawl 02/14/2011 01:45 PM
5130 Bug Resolved Normal Need a login and logout interface for authenticating a user Jing Tao 02/14/2011 01:45 PM
4762 Bug Resolved Normal create gui to control sensor from kepler Daniel Crawl 02/14/2011 01:45 PM
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5251 Bug Resolved Normal using File->Open MoML... always opens model into Sensor Site view Sean Riddle 02/14/2011 01:45 PM
4742 Bug Resolved Normal create engineering view model type Sean Riddle 02/14/2011 01:45 PM
5274 Bug Resolved Normal Trying to schedule workflow with report layout puts up prompt about no report layout Jing Tao 02/14/2011 01:45 PM
4753 Bug Resolved Normal create gui for scheduled execution of sensor workflows on server Jing Tao 02/14/2011 01:45 PM
5218 Bug Resolved Normal Create sensorML string Jing Tao 02/14/2011 01:45 PM
5077 Bug Resolved Normal add real inputs and outputs to sensor actor Daniel Crawl 02/14/2011 01:45 PM
4761 Bug Resolved Normal install and configure SPAN software on gumstix Daniel Crawl 02/14/2011 01:45 PM
4751 Bug Resolved Normal implement "run" for site layout Daniel Crawl 02/14/2011 01:45 PM
5275 Bug Resolved Normal Executing sensor-view workflow records provenance Daniel Crawl 02/14/2011 01:45 PM
5062 Bug Resolved Normal create bugs, mockups, eng view page updates showing how authentication will work Derik Barseghian 02/14/2011 01:45 PM
5226 Bug Resolved Normal User should be warned to design a report if there isn't a report when scheduling Jing Tao 02/14/2011 01:45 PM
5201 Bug Resolved Normal track changes on span server Daniel Crawl 02/14/2011 01:45 PM
5131 Bug Resolved Normal Authentication and authorization of Scheduler server Jing Tao 02/14/2011 01:45 PM
5049 Bug Resolved Normal Prompt for credentials when connecting to remote kepler server Derik Barseghian 02/14/2011 01:45 PM
5301 Bug Resolved Normal clicking on Image item Scale Property Value sometimes gives ArrayIndexOutOfBoundException Derik Barseghian 02/14/2011 12:49 PM
5293 Bug Resolved Normal Deleting a report item scrolls you to top of design Derik Barseghian 02/11/2011 12:36 PM
5083 Bug Resolved Normal possible to save a kar that loses the report layout Derik Barseghian 02/11/2011 12:30 PM
4548 Bug Resolved Normal string tokens with newlines print the escape sequences debi staggs 02/09/2011 04:14 PM
5295 Bug Resolved Normal Report designer panel gui simplification and spacing Derik Barseghian 02/08/2011 04:45 PM
5297 Bug Resolved Normal Workflow Run Manager - no indication of progress during preview runs download Derik Barseghian 02/08/2011 04:20 PM
4136 Bug Resolved Normal Workflow Run Manager - date and duration search should allow single operator-less arguments Derik Barseghian 02/04/2011 03:19 PM
5229 Bug Resolved Normal Poor component search performance Chad Berkley 02/04/2011 01:17 PM
5088 Bug Resolved Normal Report designer gui difficult to use with greater than about 3-4 items Derik Barseghian 02/03/2011 05:09 PM
4544 Bug Resolved Normal Enter key in Report Designer title invokes a search Derik Barseghian 02/02/2011 05:13 PM
5017 Bug Resolved Normal ReportLayout LSID and referral list should be maintained Derik Barseghian 02/01/2011 03:06 PM
5009 Bug Resolved Normal Opening two KARS that have the same Workflow, but that have different report layouts, will make the | Derik Barseghian 02/01/2011 03:02 PM

first layout refresh itself with the layout from the KAR that was opened most recently.

5248 Bug Resolved Normal downloading non-public kars from Search Components doesn't work Derik Barseghian 01/31/2011 06:20 PM
5061 Bug Resolved Normal Report Design Panel needs fixing wrt event listening Derik Barseghian 01/31/2011 06:05 PM
4524 Bug Resolved Normal no prompt to save a changed report Derik Barseghian 01/31/2011 06:02 PM
5272 Bug Resolved Normal kepler 2.1 suite can not be started using 'ant run' David Welker 01/31/2011 02:29 PM
5282 Bug Resolved Normal Documentation updates for 2.2 David Welker 01/31/2011 01:07 PM
5232 Bug Resolved Normal unable to open KARs saved beneath absent (e.g. third party) modules David Welker 01/28/2011 06:28 PM
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5277 Bug Resolved Normal remove test servers from Sources preferences Derik Barseghian 01/28/2011 02:00 PM
4430 Bug Resolved Normal hsql database name and port in Kepler should be configurable Daniel Crawl 01/25/2011 04:30 PM
4324 Bug Resolved Normal ptll/module-info/revision.txt not being updated Sean Riddle 01/24/2011 10:29 AM
5219 Bug Resolved Normal problems when semantically annotating or tagging a composite actor Sean Riddle 01/14/2011 02:56 PM
4988 Bug Resolved Normal Instantiating a wf as a composite that has a tag doesn't work as expected Sean Riddle 01/14/2011 02:47 PM
5260 Bug Resolved Normal Problems with unknown free-form tags Sean Riddle 01/12/2011 02:28 PM
5190 Bug Resolved Normal 6.0WorkingWithDatasets describes OPeNDAP but not DataTurbine actor Derik Barseghian 01/11/2011 02:00 PM
5191 Bug Resolved Normal GUI improvements to Save As Derik Barseghian 01/05/2011 11:31 PM
5265 Bug Resolved Normal Kepler 2.1.0 has omitted the Publish & subscribe actors from Ptolemy David Welker 01/05/2011 08:16 AM
5101 Bug Resolved Normal Composite Actor windows show wrong title after workflow Rename Aaron Aaron 01/04/2011 11:53 PM
5087 Bug Resolved Normal Image report items aren't shown when original image path doesn't resolve Derik Barseghian 01/03/2011 12:19 PM
4694 Bug Resolved Normal workflow run manager - differentiate imported runs Derik Barseghian 01/03/2011 12:03 PM
4473 Bug Resolved Normal Add WRM to bottom of report viewer for navigation Derik Barseghian 01/03/2011 11:26 AM
5193 Bug Resolved Normal Open menu items should be merged into one David Welker 12/10/2010 11:25 PM
5254 Bug Resolved Normal provenance database connections keep growing when using Reporting suite. Derik Barseghian 12/10/2010 06:48 PM
5136 Bug Resolved Normal semantic type checker always returns error Sean Riddle 12/09/2010 09:24 AM
5071 Bug Resolved Normal Improve the installer so that it is automated instead of requiring so many manual steps. Also, develop | David Welker 12/07/2010 06:33 PM

streamlined release process so that minor releases 2.1, 2.2, etc. can be accomplished more rapidly.
5127 Bug Resolved Normal Make a good way to publish a suite without changing a bunch of modules.txt files David Welker 12/07/2010 06:29 PM
5204 Bug Resolved Normal kepler application menus on each kepler window instead of in mac menu bar David Welker 12/01/2010 06:22 PM
5167 Bug Resolved Normal Fix bug so that the correct modules.ixt is always used. David Welker 12/01/2010 03:44 PM
5166 Bug Resolved Normal Patch Kepler 2.0.0 so that the module manager can switch from Kepler-2.2.0 to Kepler-2.0.0 or David Welker 12/01/2010 02:55 PM
Kepler-2.0.1

5228 Bug Resolved Normal Load splash screen and icons from the classpath, not specific modules. David Welker 12/01/2010 02:46 PM
5250 Bug Resolved Normal confusing ant options. David Welker 12/01/2010 11:33 AM
5227 Bug Resolved Normal Finish work on installers. David Welker 11/29/2010 02:54 PM
5237 Bug Resolved Normal Downloading kars on os X 10.6 locks Kepler Chad Berkley 11/10/2010 02:14 PM
5233 Bug Resolved Normal Remote component search messes up returns which have the same karFileName in kar xml Jing Tao 11/03/2010 05:58 PM
5200 Bug Resolved Normal WorkflowRun and Reporting artifacts no longer put into run-kars Derik Barseghian 11/03/2010 04:29 PM
5225 Bug Resolved Normal problems loading & saving KARs when disconnected Chad Berkley 11/01/2010 10:44 AM
5230 Bug Resolved Normal saving workflow that has instances of user created class to a KAR gives errors Chad Berkley 10/29/2010 10:23 AM
5231 Bug Resolved Normal Tools => Preferences menu item gives error on trunk Derik Barseghian 10/28/2010 01:15 PM
5093 Bug Resolved Normal module manager can leave kepler in broken or unexpected states David Welker 10/28/2010 06:42 AM
5215 Bug Resolved Normal tags from a new ontology created within Tag Manager don't show up in Tagging drop-down Sean Riddle 10/27/2010 10:44 AM
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5212 Bug Resolved Normal deselecting ontologies in Tag Manager doesn't remove tags from Tagging drop-down Sean Riddle 10/27/2010 10:42 AM
5196 Bug Resolved Normal uploading to remote server error. Derik Barseghian 09/30/2010 09:24 AM
5184 Bug Resolved Normal sanity check(s) when attempting to open owl file Sean Riddle 09/29/2010 01:21 PM
5185 Bug Resolved Normal common ontology_catalog.xml get modified Sean Riddle 09/29/2010 01:20 PM
5181 Bug Resolved Normal welcome window shows wrong version number Derik Barseghian 09/29/2010 01:13 PM
5179 Bug Resolved Normal determine if ptolemy 8.0.0 is the desired version for kepler 2.1.0 release Christopher Brooks 09/28/2010 03:21 PM
5165 Bug Resolved Normal implement a GUI Save action for KARs Derik Barseghian 09/28/2010 03:13 PM
5178 Bug Resolved Normal Documentation links are broken in help doc-index.html Derik Barseghian 09/28/2010 03:13 PM
5182 Bug Resolved Normal documentation needs updating for 2.1 Derik Barseghian 09/28/2010 03:13 PM
5183 Bug Resolved Normal Fix 6-WebServicesAndDataTransformation.xml jianwu jianwu 09/22/2010 05:33 PM
5084 Bug Resolved Normal Allow test releases in the same location as actual releases. David Welker 09/20/2010 11:18 PM
5180 Bug Resolved Normal Add a new Export File menu option that does a Save As (model xml) Derik Barseghian 09/16/2010 05:29 PM
5161 Bug Resolved Normal can't always use Module Manager to change to an older patch of a suite David Welker 09/15/2010 11:57 PM
5145 Bug Resolved Normal kepler library skin is mostly broken Jing Tao 09/15/2010 05:46 PM
5074 Bug Resolved Normal Fix the release process so modules can be released from Windows machines. David Welker 09/09/2010 09:47 PM
5125 Bug Resolved Normal Add feature to do a one-step revert of a botched update from outside of Kepler David Welker 09/09/2010 02:02 AM
5157 Bug Resolved Normal Devise approach for when patching should occur when changes occur via the module-manager. David Welker 09/08/2010 03:25 PM
5073 Bug Resolved Normal In module manager, display the current suite name as well as a fully resolved list of modules. David Welker 09/05/2010 10:15 PM
5168 Bug Resolved Normal 'ant change-to' fails at r25610 Chad Berkley 09/01/2010 03:15 PM
5065 Bug Resolved Normal In shared or administrative installations, the ability to store modules.txt and extra modules locally. This | David Welker 09/01/2010 01:02 AM

way, the module manager will work smoothly on Windows without having to run as an administrator.

5099 Bug Resolved Normal Import Dependent Modules for KAR doesn't work Derik Barseghian 08/25/2010 05:03 PM
5160 Bug Resolved Normal problem changing suites using Module Manager David Welker 08/25/2010 12:36 PM
5143 Bug Resolved Normal not getting prompted to upgrade to available patched version in test area David Welker 08/20/2010 12:23 AM
5147 Bug Resolved Normal Resolve issue with modules.txt David Welker 08/20/2010 12:08 AM
5154 Bug Resolved Normal Curiously, no progress indicator shows progress during patching. David Welker 08/18/2010 06:53 PM
5119 Bug Resolved Normal Make switching to a specific set of modules turn off automatic update feature Derik Barseghian 08/12/2010 03:55 PM
5137 Bug Resolved Normal database exception when using 'ant run' at windows 7. Daniel Crawl 08/12/2010 12:11 PM
5140 Bug Resolved Normal Ecogrid Authentication Error at Kepler trunk on windows 7. ben leinfelder 08/12/2010 12:11 PM
5121 Bug Resolved Normal Provide a button to manually check for updates David Welker 08/11/2010 06:10 PM
5126 Bug Resolved Normal Determine whether we need to make installers for all minor releases David Welker 08/11/2010 05:43 PM
5070 Bug Resolved Normal Changing the "Available Modules" tab in the Module Manager to "Available Suites and Modules" David Welker 08/11/2010 12:59 PM
4191 Bug Resolved Normal Eclipse build is slow the first time "Copying resources to the output folder" jilanwu jianwu 08/09/2010 03:29 PM
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5082 Bug Resolved Normal Eclipse build fails because of invalid archive jianwu jianwu 08/05/2010 04:27 PM
5097 Bug Resolved Normal kepler.sh accepts a limited number of arguments jianwu jianwu 08/05/2010 03:52 PM
5124 Bug Resolved Normal Add/fix the ability to patch a suite David Welker 08/04/2010 02:34 PM
5096 Bug Resolved Normal Reporting on a RecordToken fails Derik Barseghian 08/02/2010 10:57 AM
5094 Bug Resolved Normal reports do not display matrix or xml token data Derik Barseghian 08/02/2010 10:56 AM
5115 Bug Resolved Normal enable system properties setting by updating kepler.sh or kepler.bat Chad Berkley 07/30/2010 12:51 PM
5026 Bug Resolved Normal Error dialog pop up in RC3 when closing the ImageJ window after workflow execution. Sean Riddle 07/29/2010 01:40 PM
4342 Bug Resolved Normal apple-extensions module on windows make Eclipse build difficult David Welker 07/23/2010 09:43 AM
5089 Bug Resolved Normal Replace operating system specific files with operating system specific modules. David Welker 07/22/2010 08:59 PM
5100 Bug Resolved Normal Report Layout designed in a composite actor window is lost Derik Barseghian 07/22/2010 06:35 PM
4118 Bug Resolved Normal Web Service Actor stored in Library Daniel Crawl 07/14/2010 10:20 AM
5092 Bug Resolved Normal 2.0 user manual has no table of contents Chad Berkley 07/14/2010 10:04 AM
5051 Bug Resolved Normal Semantically annotate during Save Archive a workflow with remote data set Error Chad Berkley 07/07/2010 10:45 AM
5066 Bug Resolved Normal Fix for ImagedJ so that preferences are stored in an area other than the installation space. This may David Welker 07/06/2010 05:58 PM

require a change to ImagedJ source code.

5047 Bug Resolved Normal Rename the tagging docs tagging.pdf Sean Riddle 06/21/2010 11:19 AM
5024 Bug Resolved Normal Uninstaller couldn't delete the rc3 folder on windows 7 Chad Berkley 06/16/2010 09:22 AM
5008 Bug Resolved Normal Research Copyrights before 2.0.0 release. David Welker 06/16/2010 09:20 AM
5043 Bug Resolved Normal Help => Modules Documentation menu not in 2.0 debi staggs 06/11/2010 10:53 AM
5031 Bug Resolved Normal Fail to switch to other suite from module manager of Kepler-2.0-RC3 David Welker 06/10/2010 03:03 PM
4997 Bug Resolved Normal SEEK/garpModel_ImagedJ.xml has an exception while opening David Welker 06/09/2010 01:38 PM
5044 Bug Resolved Normal Can't insert null record using Database Writer actor Derik Barseghian 06/08/2010 05:25 PM
5034 Bug Resolved Normal Need to generalize copying workflow demos from areas other than outreach. Derik Barseghian 06/07/2010 03:59 PM
4647 Bug Resolved Normal Write documentation for Reporting in the style of Kepler Docs debi staggs 06/07/2010 12:16 PM
4660 Bug Resolved Normal Clicking in a section header highlights all the text. debi staggs 06/07/2010 07:09 AM
4526 Bug Resolved Normal multi-line entries can be put into text items in reports, but they are displayed on a single line debi staggs 06/07/2010 07:06 AM
4983 Bug Resolved Normal cannot run kepler.sh in RC2 Chad Berkley 06/01/2010 11:18 AM
5022 Bug Resolved Normal 2.0-RC3 Windows installer creates Kepler 2.0-RC2 start menu choice, not Kepler 2.0-RC3 Chad Berkley 05/28/2010 08:35 AM
4985 Bug Resolved Normal problem with workflows using Rexpression on Windows XP Derik Barseghian 05/26/2010 03:08 PM
5025 Bug Resolved Normal Couldn't run the workflows 00-StatisticalSummary and 08-CommandLine_2 Derik Barseghian 05/26/2010 02:41 PM
4972 Bug Resolved Normal Write documentation for workflow-run-manager module Derik Barseghian 05/26/2010 01:35 PM
5014 Bug Resolved Normal Add documentation to resources for the Workflow Run Manager module Derik Barseghian 05/26/2010 01:34 PM
5013 Bug Resolved Normal Add documentation to resources for Tagging module Sean Riddle 05/25/2010 12:50 PM
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4971 Bug Resolved Normal Write documentation for tagging module Sean Riddle 05/25/2010 12:49 PM
5029 Bug Resolved Normal Parameter changes can be committed without clicking the commit button Chad Berkley 05/25/2010 11:50 AM
5021 Bug Resolved Normal release date is wrong in installer readme Chad Berkley 05/23/2010 10:48 PM
4994 Bug Resolved Normal ant installer fails with "Invalid directory 'dir' ... outreach-2.0.0/resources" Chad Berkley 05/23/2010 09:29 PM
3072 Bug Resolved Normal Security issues with distributed execution jlanwu jianwu 05/20/2010 09:20 PM
5023 Bug Resolved Normal The desktop icon of rc3 is a blank page on windows vista Chad Berkley 05/20/2010 02:20 PM
4993 Bug Resolved Normal Kepler-2.0 cannot be built under windows because of apple-extensions Chad Berkley 05/20/2010 12:34 PM
5019 Bug Resolved Normal R_output_example.xml fails Chad Berkley 05/20/2010 11:32 AM
4984 Bug Resolved Normal user mailing list is wrong Chad Berkley 05/20/2010 04:44 AM
4987 Bug Resolved Normal RC2 cannot find R pkg Chad Berkley 05/20/2010 04:40 AM
4991 Bug Resolved Normal Kepler-2.0-RC2 fails to start for a non-admin user after admin install Chad Berkley 05/20/2010 04:38 AM
4992 Bug Resolved Normal In a shared installation, how does the user get the demo? Chad Berkley 05/20/2010 04:37 AM
4996 Bug Resolved Normal 2.0-RC2 demos don't work Chad Berkley 05/20/2010 04:25 AM
5005 Bug Resolved Normal regular user couldn't start kepler after it was installed on windows 7 Chad Berkley 05/20/2010 04:22 AM
5015 Bug Resolved Normal Export of runs contain different, and missing or extra reporting items now Derik Barseghian 05/19/2010 04:37 PM
4969 Bug Resolved Normal Exported run-kar puts a roml at root of Components tree Derik Barseghian 05/19/2010 04:22 PM
4977 Bug Resolved Normal Can't associate multiple sets of reporting artifacts in one kar with different executions Derik Barseghian 05/19/2010 02:59 PM
4973 Bug Resolved Normal Save Archive sometimes saves more or less than it should in WRP Derik Barseghian 05/17/2010 01:56 PM
4896 Bug Resolved Normal When exporting multiple runs only 1 ROML is placed in KAR debi staggs 05/14/2010 02:24 PM
5010 Bug Resolved Normal 2.0 branch fails to launch on XP - tries to compile apple-extensions-2.0 Derik Barseghian 05/14/2010 02:05 PM
4956 Bug Resolved Normal make sure matlab works with installed version of kepler 2.0 jianwu jianwu 05/13/2010 04:54 PM
5006 Bug Resolved Normal create and copy demo dir directory into KeplerData on startup if doesn't exist Derik Barseghian 05/13/2010 02:54 PM
4986 Bug Resolved Normal Problem with property DEMODIR on Windows XP Derik Barseghian 05/13/2010 02:54 PM
4910 Bug Resolved Normal Test module installation system debi staggs 05/13/2010 01:40 PM
4915 Bug Resolved Normal PortParameters instantiated from Outline tab cannot be deleted Derik Barseghian 05/12/2010 04:46 PM
4938 Bug Resolved Normal Reporting suite no longer works on its own Derik Barseghian 05/11/2010 05:01 PM
4982 Bug Resolved Normal NPE when starting with no network Chad Berkley 05/10/2010 11:51 PM
4998 Bug Resolved Normal DataTurbine actor instantiation problem Derik Barseghian 05/10/2010 04:13 PM
4990 Bug Resolved Normal Ptolemy documentation missing Christopher Brooks 05/09/2010 09:34 PM
4976 Bug Resolved Normal Importing run archive from a different namespace is broken Derik Barseghian 05/06/2010 02:02 PM
4980 Bug Resolved Normal Tagging a run now creates two identical tags in the GUI Sean Riddle 05/06/2010 12:10 PM
4979 Bug Resolved Normal ROML has type of Reportinstance instead of ReportLayout in kar manifest Derik Barseghian 05/05/2010 12:22 PM
4966 Bug Resolved Normal Make simple GUI mods for module manager debi staggs 05/05/2010 11:05 AM
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4928 Bug Resolved Normal Clean up kepler-project.org KAR files Jing Tao 05/04/2010 10:34 AM
4970 Bug Resolved Normal Make non-instantiable items in local KARs not draggable Sean Riddle 05/03/2010 05:06 PM
4968 Bug Resolved Normal Could not validate generated KAR file for uploading to repository Jing Tao 04/30/2010 05:33 PM
4957 Bug Resolved Normal Tags are not visible under Java 1.6 Sean Riddle 04/30/2010 01:46 PM
4965 Bug Resolved Normal Create and use configuration parameter for writing run-kars Derik Barseghian 04/29/2010 06:23 PM
4964 Bug Resolved Normal Provenance turns off for unsupported director, but doesn't send toggle event Daniel Crawl 04/29/2010 05:29 PM
4960 Bug Resolved Normal NPE from TableSorter when repeatedly executing a small workflow in WRP Derik Barseghian 04/28/2010 04:26 PM
4681 Bug Resolved Normal Check all file properties before release Chad Berkley 04/28/2010 01:25 PM
4936 Bug Resolved Normal Preferences for searching remote repositories are not maintained across runs Chad Berkley 04/27/2010 03:03 PM
4958 Bug Resolved Normal Tags colors are all white by default under Windows XP with Java 1.5 Sean Riddle 04/27/2010 02:00 PM
4944 Bug Resolved Normal Unsaved report warning happens once per window Derik Barseghian 04/26/2010 05:26 PM
4959 Bug Resolved Normal Reporting call to getDefaultProvenaceRecorder occasionally gets an NPE Derik Barseghian 04/26/2010 05:08 PM
4893 Bug Resolved Normal WRP Kepler Frame vertically fills entire screen Derik Barseghian 04/26/2010 03:37 PM
4955 Bug Resolved Normal Error trying to instantiate workflow from Outline tab Aaron Aaron 04/26/2010 02:21 PM
4765 Bug Resolved Normal semantic annotation doesn't appear until you click on workflow Sean Riddle 04/21/2010 03:16 PM
4952 Bug Resolved Normal Error recording workflow structure on workflow after deleting run Daniel Crawl 04/21/2010 01:45 PM
4954 Bug Resolved Normal Duration value on imported runs is incorrect Derik Barseghian 04/21/2010 11:41 AM
4942 Bug Resolved Normal KarXmlGenerator generated a invalid kar xml if KarEntry has dependsOnModule element Jing Tao 04/20/2010 04:58 PM
4357 Bug Resolved Normal Workflow Run Manager does not mark last failed execution red Derik Barseghian 04/19/2010 05:40 PM
4231 Bug Resolved Normal Workflow Run Manager - failed runs should be highlighted red Derik Barseghian 04/19/2010 05:38 PM
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